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The following guide is intended to specify a consistent style and format to be used for MERGA
annual conference proceedings. The style is based on the standard MERGA style; the format is
based on that used in the Mathematics Education Research Journal, adapted for the larger page
size used for the Proceedings. This document is itself an example of the format it specifies. The
electronic version contains MS Word “styles” which authors can use to format their papers
quickly and uniformly.

All papers for presentation at MERGA’s annual conferences are submitted electronically.
Accepted papers will then be published in the conference Proceedings, printing directly from
the submitted files. Since no editing is possible at this stage, it is necessary to impose strict
specifications on submitted papers if the final product is to have a professional appearance.

Submitting Conference Papers
You are required to submit a blind version of your paper as well as the full, final version.
To create the blind version that maintains the pagination, follow the following procedure:
•
•
•
•

Create a copy of the paper and save it under a different name.
Turn on the “overtype” mode.
Overtype every letter in every occurrence of each author’s name and institution (in the
title, in the text, and in the references) with a space.
Turn off the “overtype” mode.

Save your papers as a .doc using the following file name as indicated below:
Table 1
Conventions for Naming Papers
Presentation Type
Blind version
Research Papers
Corresponding author last
name_Blind_RP.doc
e.g., Smith_Blind_RP.doc
Symposia Papers
Corresponding author last
name_Blind_SYMP.doc
e.g.,
Smith_Blind_SYMP.doc
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Full Paper
Corresponding_author_las
t name_Full_RP.doc
e.g., Smith_Full_RP.doc
Corresponding author last
name_Full_SYMP.doc
e.g.,
Smith_Full_SYMP.doc

Email abstracts only for Short Communications, Round Table Presentations, and Posters using
this format.
Save your abstracts as indicated below:
Table 2
Conventions for Naming Abstracts
Abstracts
Short Communications
Corresponding author last
name_Full_SC.doc e.g., Smith_Full_SC.doc
Round Table Presentations
Corresponding author last name_Full_RT.doc
e.g., Smith_Full_RT.doc
Posters

Corresponding author last
name_Full_PO.doc e.g., Smith_Full_PO.doc

Formatting Specifications and Instructions
All papers are to be prepared using Microsoft Word in either Windows or Macintosh
format. The following is written for Windows and may have to be adapted for Macintosh. The
following specifications are stated in terms of Word “styles”. All styles to be used for
formatting conference papers have a name which begins with CONF (and are shown in this
document in bold type). Specific CONF styles are defined for the different parts of a
manuscript: body text, various types of headings, abstracts, and so on.
Styles enable you to format text in one step without having to format font, paragraph, and
so on separately. It is not necessary for you to set up the CONF styles, they are attached to this
document. To achieve uniformity of appearance, it is essential that authors use the attached
CONF styles and no others.
The following steps assume that you have already written a paper in the standard MERGA
style and are satisfied with its content. You are now ready to bring it into the standard MERGA
annual conference format.

Step 1: Initial Editing
Open your file and carry out these initial editorial steps:
• If you have written text with carriage returns (shown by a paragraph sign ¶ when you
display non-printing characters) at the end of each line, delete them all. Use a carriage
return only to separate paragraphs.
• Delete any blank lines (e.g., before or after paragraphs or headings).
• Delete any page breaks.
• Delete any tabs (shown by an arrow → when you display non-printing characters),
except where used within table cells.
• Delete any headers and footers (including page numbers).
• Check that all inverted commas (single and double) are “smart” (as opposed to
"straight"). If you have any straight inverted commas, first click on Autocorrect in the
Tools menu and check Change 'Straight Quotes' to ‘Smart’ Quotes. Then click on
Replace in the Edit menu, type ' (a single inverted comma) in Find What and Replace
With, and then click on Replace All. Then type " (a double inverted comma) in Find
What and Replace With, and then click Replace All again. All inverted commas should
then be converted to smart ones.
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•
•
•
•

If you have used bold or underlined characters for emphasis, or underlined book and
journal titles in the reference list, change them to italics.
If you have typed two spaces between sentences, change this to one space. To ensure
that you find all such occurrences, click on Replace in the Edit menu, type two spaces
in Find What and one space in Replace With, and then click on Replace All.
If you have typed your tables after the references, move them to a place in the text near
to where they are referred to.
If you have put any diagrams at the end of the manuscript, move them to a place in the
text near to where they are referred to. If any diagrams are in hard copy, replace them
by electronic versions (e.g., by scanning them) and embed them in the text. If
you have typed figure captions on a separate page, move them below the corresponding
figure.

Step 2: Preparing to Format Your Manuscript
Next, you need to copy your manuscript into a file which has all the CONF styles available.
To do this, proceed as follows:
1. You may wish to start by printing this document, for reference once you have replaced
this text with the contents of your paper.
2. Make a copy of the file containing this document, giving the copy some distinctive
name—possibly including the year of the conference for which your paper is intended.
(Open this file and then use Save As in the File menu to save it under a different name.
Or use your File Manager). Alternatively, use the other template available from the
website.
3. Open the new file and delete the entire text (Click on Select All in the Edit menu, and
then press Delete).
4. Open your manuscript file and copy the entire text to the clipboard (Click on Select All
in the Edit menu, then click on Copy in the Edit menu).
5. Return to the new file and paste your manuscript text into it (Click on Paste in the Edit
menu).
You now have a copy of your manuscript file with all the CONF styles available. This is the
file that, after editing, you will email to the conference editorial committee.

Step 3: Formatting your Manuscript
You are now ready to format each paragraph of your manuscript using the appropriate
CONF style. The general procedure for applying a style is as follows:
1. First select the text to be formatted. This should be a whole number of paragraphs.
If you select more than one paragraph, the same style will be applied to all of them.
2. Then click on the downward arrow next to the Style menu (usually to be found on the
top left of the screen) and click on the required CONF style. The selected text will be
automatically formatted.
Notice that, even when using styles, it is occasionally necessary to adjust the spacing before or
after a paragraph “by hand”. It may also be necessary to change the first-line indentation. To
do either of these, use the Paragraph command in the Format menu.
Each item of your manuscript is to be formatted as described below. If you are in any doubt
as to the interpretation of the instructions, examine the formatting of the corresponding
paragraphs of this document.
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Title. Apply CONFTitle to format the title of your paper. If the title runs onto two lines,
use a line break (SHIFT-ENTER) to even up the two lines or to make a more sensible break.
Do not use a carriage return (ENTER) for this purpose.
Author details. Use three lines for each author:
1. First and last name (no middle initial)—apply CONFAuthor1.
2. Affiliation (only the name of the university or other institution, no department)— apply
CONFAuthor2.
3. E-mail address—apply CONFAuthor3.
For two authors, place each author’s details in a cell of a 1 x 2 table. For three or four authors,
use a 2 x 2 table and merge the two cells in the second row if necessary. Applying the
CONFAuthor styles will then centre the author details within each cell.
Underline the name of the author who will be presenting the paper at the conference.
Abstract. Every paper should begin with a one-paragraph abstract of not more than 8 lines.
This paragraph should not have any heading, nor should the paragraph immediately following.
Format the abstract using CONFAbstract.
Normal text. Normal text paragraphs are formatted using CONFNormalText. If a
paragraph following a displayed quotation or list continues the sense of the paragraph
immediately preceding the quotation or list, change the first-line indentation of this paragraph
to 0 cm.
Headings. Three levels of heading may be used in conference papers:
1. Apply CONFHeading1 to Level 1 headings (such as Rationale, Method, Results,
Discussion, Acknowledgments, and References). In these headings, capitalise all major
words (verbs, nouns, adjectives, adverbs, and any other words of four or more letters),
including both parts of hyphenated words. Delete any heading such as Introduction
between the abstract and the beginning of the main text.
2. Apply CONFHeading2 to Level 2 headings and capitalise all major words. If such a
heading immediately follows a Level 1 heading, reduce space before to 0 pt.
3. The third level is the paragraph heading. This consists of the first words of a normal
text paragraph, ending with a full stop, and with only the first word and any proper
nouns capitalised. To format a Level 3 heading, set the heading in italics and apply
CONFHeading3 to the whole paragraph.
Displayed quotations. Quotations of more than 40 characters should be set as displayed
text, without quotation marks. To illustrate this, we quote from Mitchelmore and Owens
(1999):
Display quotations of 40 words or more, and do not use quotation marks. Place the page reference
(together with the source citation, if not given in the body of the text) in parentheses after the last
character in the quotation, with no full stop following it [7.03]. (p. 1)

To achieve this format, apply CONFQuote to the quoted text.
Lists. Lists may be either numbered or bulleted. To format such a list, delete existing
numbers or bullets and apply CONFNumbers or CONFBullets to all paragraphs. Then change
the space before the first item and after the last item of the list to 6 pt.
Figures. Each figure must be referred to in the text and must have a caption below it, as
shown in Figure 1. Set the identifier, such as “Figure 1”, in italics followed by a full stop. In
the caption itself, capitalise only the first word and proper nouns, and end with a full stop. For
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captions extending over two lines, split the text according to the sense and to avoid unbalanced
line lengths. Avoid captions longer than two lines, moving text as necessary into the body of
the article. Format the figure using CONFFigure and the caption using CONFFigureCaption.

Figure 1. Artist at work creating this figure.

Tables. A table title is set in two paragraphs: an identifier such as “Table 1” in the first
paragraph and text indicating the content of the table in the second paragraph. In both
paragraphs, all significant words are capitalised and there is no full stop at the end. Format the
first paragraph with CONFTable1 and the second paragraph with CONFTable2. Each table
must be referred to in the text.
Set the table itself using the Table command. The design of a table can be rather
complicated, but the following points summarise the main guidelines. See the Concise rules of
APA style 5.04-5.19 for more detailed advice on layout.
•

•

•
•

Use no vertical rules and use only three horizontal rules across the full width of the
table: above and below the column heads and below the last line of the table. These
three rules should extend across the full width of normal text. Use shorter rules to
indicate the extent of heads spanning two or more columns. All rules should be pt.
Format all paragraphs in the table (including the headings) using CONFTableText.
Then change the space before the paragraphs immediately below each rule at the top of
the table to 3 pt. If it is necessary for clarity to introduce line spaces to separate sections
of the table, increase space after appropriate paragraphs to 12 pt.
Left-align all columns of text, including the column heads; but use tabs to align the
decimal points in columns of numbers, and centre the corresponding column heads.
For tables of numerical data, use regular font for any subheadings within the body of
the table. For tables containing mostly text and/or diagrams, use italic font.

Format table footnotes using CONFTableFoot. Give footnotes in the following order:
1. A general note starting with the word Note.—all in one paragraph and ending with a
full stop.
2. Specific footnotes: indicated by superscript lower case letters—one paragraph for each
footnote and ending with a full stop.
3. Significance levels: represented by various numbers of asterisks. The maximum
number of asterisks should be equal to the number of different significance levels given
in that table. Indicate multiple significance levels on one line, separated by a full stop
and five blank spaces (e.g., “*p < 0.01. **p < 0.001.”) Text footnotes. Do not use text
footnotes.
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Acknowledgments. Include all acknowledgments in a separate paragraph headed
Acknowledgments just before the reference list. Format the heading with CONFHeading1 and
the text with CONFNormalText.
Reference list. Format all entries in the reference list using CONFReference. Use
nonbreaking spaces to avoid separating authors’ initials from their surname.

Step 4: Final Adjustments
There are now a few final steps before the paper can be submitted.
•

Apply CONFSubscript to all subscripts and CONFSuperscript to all superscripts
(including Table footnote numbers and letters).
• Underline all internet references.
• Check that the application of styles has not changed italics to regular font, or symbols
to normal text font.
• Use Print Preview in the File menu to check that there are no large spaces before your
tables or figures and that no table is split across two pages. If either of these problems
occurs, move tables and/or figures to a different position until the spaces are minimised.
Note that tables and figures must always fit between two paragraphs; it may be
necessary to split a long paragraph into two shorter ones in order to obtain a good fit.
• A conference paper may not be more than 8 pages long. If your formatted manuscript
has more than 8 pages, edit it accordingly. Then check again that there are no large
spaces before tables or figures.
• Check that all works cited in the text are listed in the references, and vice versa.
• Use the SpellChecker to check all spelling.
Finally, when you are sure that your paper is in its finished form, save your file as a MSWord
document.

Introduction to Styles and Formats
The appearance of a document depends on style and format:
•
•

Style refers to the way words and symbols are used, irrespective of how they are laid
out on the printed page.
Format refers to the way words and symbols are laid out on the printed page,
irrespective of whether they make sense or not.

Both are specified in this document, which has three purposes:
• to reiterate MERGA’s standard style specifications;
• to specify a uniform format for annual conference papers; and
• to provide instructions on how to achieve this format with the minimum of effort.
It is itself prepared according to these style and format specifications and, in its electronic form,
contains all the necessary formatting tools.

MERGA Publications Style
MERGA conference papers should follow the standard MERGA publications style
(Mitchelmore & Owens, 1999). For authors’ convenience, this style is reproduced below.
MERGA style follows “APA style” as specified in the official guide to APA style, Publication
Manual of the American Psychological Association (2020) and supplemented by the latest
recommendations
for
referencing
electronic
documents
(available
at
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http://www.apastyle.org/apa-style-help.aspx), with minor modifications for Australasian
usage. Below, the most crucial elements of APA style are summarised and the modifications
for MERGA publications listed in detail.

The Most Crucial Elements of APA style
Authors should read Chapters 1 of the Publication Manual of the APA for valuable advice
on the content and organisation of a manuscript and the expression of ideas. Editorial style is
specified in detail in Chapters 2 and 3 and these specifications should be strictly followed. The
following guidelines would avoid some of the most common errors.
•
•
•
•
•
•
•

•
•

Spell out words like “and”, “for example”, and so on—except when they occur within
parentheses (then use “&”, “e.g.”, etc.). Always follow “e.g.” and “i.e.” with a comma
[3.07]. Also, use “&” instead of “and” in the reference list.
Leave only a single blank space after each punctuation mark (exception: internal full
stops in abbreviations like “e.g.”).
Text omitted in a quotation is always shown by three dots (full stops not separated by
spaces). The three dots should be separated by a single blank space from the following
and preceding text (which might be a full stop).
Use double quotation marks for quotes in text, except for quotes within quotes.
Use italics (not quotation marks) for technical terms at their first definition and for
foreign words.
Note the different way of citing a range of page numbers in the reference list for
chapters in a book (e.g., “This book (pp. 32–49)”) and articles in a journal (e.g., “This
Journal, 58(2), 253–258”).
Pay particular attention to the other specifications for listing references. Most variations
are included among the examples given in the Publication Manual of the APA. The
reference list in the present document contains examples of the most common
references: to books (Mitchelmore & Owens, 1999), chapters in books (Truran &
Truran, 1998), and journal articles (Sullivan et al., 2000).
For electronic documents, follow a similar format as for printed material and indicate
when and from where it was retrieved. (See, for example, Bishop et al., 1999).
Check that all works cited in the text appear in the reference list, and vice versa.

Modifications of APA Style for MERGA Usage
The following modifications either amend APA style for Australasian usage or clarify and
extend its application in MERGA publications.
Spelling. Use Australasian academic English (not British or US English). The standard
spelling reference is The Macquarie Dictionary (2nd Revision, 1987). In particular, spell words
like “visualise” with the ending -ise, not -ize, and words like “centre” with the ending -re, not
-er. Before using a spell checker, ensure that you specify the language used in the document as
English (AUS).
Punctuation. As in Australasian academic English, place periods and commas outside
closing quotation marks, unless the text quoted ends with a period. However, contrary to
Australasian academic English, always insert a comma in lists of three or more items before
the final “and” or “or” (e.g., “Bloggs, Bloggs, and Bloggs” and “1, 2, 3, or 4”). This usage
provides consistency with the use of commas in references and often helps to make the meaning
clear.
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Use letters (a), (b), and so on to identify elements in more complex lists, separated by
commas, colons, and semi-colons as appropriate. A sentence following a colon should begin
with a capital letter.
Numbers. Place a zero before the decimal point in all numbers less than 1 (e.g., p < 0.05).
References to Conference Papers. The specifications for references to conference papers
in the Publication Manual of the APA do not cover many of the conferences to which MERGA
members frequently refer. The following instructions are designed to extend APA style to cover
such conferences:
•

•
•
•

Where the proceedings are published under a specific title, use this title as the main
identifier and add an indication that the item consists of conference proceedings. Where
no specific title is given, use the title “Proceedings of …”. Capitalise only the first
words of the titles and subtitles of conference proceedings but capitalise all words in
the names of organisations and of conferences. Notice that, whereas an “International
Congress on Mathematical Education” is the name of a conference, an “annual
conference [of an organisation]” is not.
Use abbreviations such as “16th” for “sixteenth” in the names of conferences.
Whenever the body that organises the conference also publishes the proceedings,
abbreviate the name of the organising body in the publisher information.
Where the place of a conference is not otherwise identifiable, include this information
in the conference title.

Refer to the reference list at the end of this document for examples of how to cite the following
types of conference papers:
• Papers in proceedings published under a specific title (Galbraith et al., 1999)
• Papers in proceedings published without specific title (Forgasz & Leder, 1998)
• Papers in proceedings published electronically (Bishop et al., 1999)
• Unpublished papers (Davey & Pegg, 1991; Outhred et al., 1996)
• Unpublished papers available from ERIC (Mitchelmore & White, 1995)
For ease of reference, bibliographic details of MERGA, AAMT, MAV, and PME conference
proceedings from 1990 are given in the Appendix.
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Appendix: Bibliographic Details of Selected Conference Proceedings
Table 3
MERGA Annual Conferences
No. Date
Title
13
1990
14
1991
15

1992

16

1993

17

1994

18
19

1995
1996

20

1997

21

1998

22

1999

23

2000

24

2001

25

2002

26

2003

27

2004

28

2005

29

2006

30

2007

Space: The First and
Final Frontier
Contexts in Mathematics
Education
Challenges in
Mathematics Education:
Constraints on
Construction
Galtha
Technology in
Mathematics Education
People in Mathematics
Education
Teaching Mathematics in
New Times
Making the Difference
Beyond 2000
Mathematics Education
Beyond 2000
Numeracy and Beyond
Mathematics Education
in the South Pacific
Mathematics Education
Research:
Innovation,
Networking, Opportunity
Mathematics Education
for the Third Millennium:
Towards 2010
Building
Connections:
Research, Theory and
Practice

Editors
J. Watson
J. Malone, T. Herrington,
& D. Miller
B. Southwell, B. Perry, &
K. Owens
B. Atweh, C. Kanes, M.
Carss, & G. Booker
G. Bell, B. Wright,
N. Leeson, & J. Geake

Place
Hobart, TAS
Perth, WA

B. Atweh & S. Flavel
P. C. Clarkson

Darwin, NT
Melbourne, VIC

F. Biddulph & K. Carr

Rotorua, NZ

C. Kanes, M. Goos, &
E. Warren
J. M. Truran & K. M.
Truran
J. Bana

Gold Coast,
QLD
Adelaide, SA

J. Bobis, B. Perry, & M.
Mitchelmore
K. Irwin & M. Thomas

Sydney, NSW

L. Bragg, C. Campbell, &
G. Herbert

Geelong, VIC

I. Putt, R. Faragher, & M.
McLean

Townsville,
QLD

P. Clarkson, A. Downton,
D. Gronn, M. Horne, A.
McDonough, R. Pierce &
A. Roche
Identities, Cultures and P. Grootenboer,
Learning Spaces
R. Zevenbergen,
& M. Chinnappan
Mathematics: Essential J. Watson & K. Beswick
Research, Essential
Practice
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Sydney, NSW
Brisbane, QLD
Lismore, NSW

Fremantle, WA

Auckland, NZ

Melbourne, VIC

Canberra, ACT

Hobart, TAS

31

2008

Navigating Currents and M. Goos, R. Brown, &
Charting Directions
K. Makar
Crossing Divides
R. Hunter, B. Bicknell, &
T. Burgess
Shaping the Future of L. Sparrow, B. Kissane, &
Mathematics Education
C. Hurst
Mathematics: Traditions J. Clark, B. Kissane, J.
and [New] Practices
Mousley, T. Spencer, &
S. Thornton

Brisbane, QLD

32

2009

33

2010

34

2011

35

2012

Mathematics Education: J. Dindyal, L.P. Cheng, &
Expanding Horizons
S. F. Ng

Singapore

36

2013

V. Steinle, L. Ball, &
C. Bardini

Melbourne, VIC

37

2014
2015

39

2016

J. Anderson, M. Cavanagh,
& A, Prescott
M. Marshman, V. Geiger, &
A. Bennison
B. White, M. Chinnappan, &
S. Trenholm

Sydney, NSW

38

40

2017

41

2018

42

2019

43

2020
2021

44

2022

Mathematics education:
Yesterday, today and
tomorrow
Curriculum in Focus:
Research Guided Practice
Mathematics Education
in the Margin
Opening up Mathematics
Education Research
40 years on: We are Still
Learning!
Excellence in
Mathematics Education:
Foundations and
Pathways
Mathematics Education
Research: Impacting
Practice
COVID-19 restrictions
Making Waves, Opening
Spaces
Mathematical
Confluences and
Journeys

Wellington, NZ
Fremantle, WA
Adelaide, SA

Maloolaba,
QLD
Adelaide, SA
Melbourne, VIC

Y. H. Leong, B. Kaur,
Singapore
B. H. Choy, J. B. W. Yeo, &
S. L. Chin
G. Hine, S. Blackley, &
A. Cooke

Perth, WA

J. Hunter, P. Perger, &
L. Darragh
N. Fitzallen. C. Murphy,
V. Hatisaru, & N. Maher

Auckland, NZ
Launceston,
TAS

Note. MERGA conference proceedings up to 1998 were published by MERGA at the place where the conference
was held. From 1999 to 2002, proceedings are published by MERGA at Sydney. From 2003 to the current time,
they have been published at the place where the conference was held.
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Table 2
AAMT Biennial Conferences
No.

Date

13

1990 Mathematical Turning Points:
Strategies for the 1990s
1993 New Horizons, New Challenges
1995 FLAIR: Forging Links and
Integrating Resources
1997 Mathematics: Creating the Future
1999 Mathematics: The Next Millennium
2001 Mathematics: Shaping Australia
2003 Mathematics ~ Making Waves
2005 Making Mathematics Vital

14
15
16
17
18
19
20
21
22
23
24
25
26
27
28

Title

Editors

2007 Mathematics: Essential for
Learning, Essential for Life
2009 Mathematics: It’s Mine
2011 Mathematics: Traditions and [New]
Practices
2013 Mathematics: Launching Futures
2015 Mathematics: Learn, Lead, Link
2017 Capital Maths
2019
2021 Future Proofing: AAMT eCon

K. Milton & H. McCann
T. Herrington
A. Richards
N. Scott & H. Hollingsworth
K. Baldwin & J. Roberts
B. Lee
M. Goos & T. Spencer
J. Anderson, M. Coupland &
T. Spencer
K. Milton, H. Reeves, T. Spencer
B. Kissane, M. Kemp, L. Sparrow,
C. Hurst & T. Spencer
J. Clark, B. Kissane, J. Mousley,
T. Spencer, & S. Thornton
S, Herbert, J. Tillyer, & T. Spencer
N. Davis, K. Manuel, & T. Spencer
V. Barker, T. Spencer, & K. Manuel

Note. AAMT conference proceedings are published by AAMT at Adelaide.
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Table 3
PME Annual Conferences
Date Editors
14
15
16
17

1990
1991
1992
1993

18
19
20
21
22
23
24
25
26
27

1994
1995
1996
1997
1998
1999
2000
2001
2002
2003

28
29
30

2004
2005
2006

31

2007

32

2008

33

2009

34
35
36
37
38

2010
2011
2012
2013
2014

39
40
41

2015
2016
2017

42

2018

43

2019

Place

G. Booker, P. Cobb, & T. de Mendicuti
F. Furinghetti
W. Geeslin & K. Graham
I. Hirabayashi, N. Nohda, K. Shigematsu,
& F.-L. Lin
J. P. da Ponte & J. F. Matos
L. Meira & D. Carraher
L. Puig & A. Gutiérrez
E. Pehkonen
A. Olivier & K. Newstead
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